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This document provides instruction for creating a customized compliance plan template for your specific 
agency by using the “CompliancePlan_v####.xlsm” tool and accompanying folders and files (including 
“CompliancePlan_v####.docm” and “complianceplan_blank.csv”), distributed to you by the Center for 
Technology & Training in collaboration with the Transportation Asset Management Council and the 
Michigan Department of Transportation.  

Compliance plan data for your agency will need to come from the completed Pavement Asset 
Management Plan workbook or Bridge Asset Management Plan workbook or will need to be entered 
manually into the complianceplan_blank.csv Microsoft Excel spreadsheet. To enter data manually, 
instructions are available by contacting the CTT. This Instruction Guide will detail how to merge data 
into the Word template using the “CompliancePlan_v####.xlsm” tool. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For more information  
 
Select this symbol to learn more information about the tool. 

 

Select this symbol to discover where related requirements and/or recommendations can be found. 
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Saving the template files on your computer 
The tools for creating a customized compliance plan template can be downloaded as a zipped file from 
ctt.mtu.edu/asset-management-resources. After unzipping the tools folder, it is recommended that the 
“complianceplan_v####_tools” folder be saved in you Documents or My Documents folder on your 
desktop; if it is desired to rename this (sub)folder, use a unique name such as “CompliancePlan-2021”. 
Please note: DO NOT RENAME the included folders or files at any time. Also, if your computer 
system backs up your files to an online cloud service, you will need to save the asset compliance plan 
tools to a USB drive and work with the files on the USB drive.   

The tools within the “complianceplan_v####_tools” folder consist of (see figure below): 

• the.xlsm file, “CompliancePlan_v2021.xlsm”, housed in the main folder 

• one subfolder 

o the “backgroundprocesses” subfolder that contains the generic Word template 
“CompliancePlan_v2020.docm” and a blank .csv template “complianceplan_blank.csv” 

Do not rename these files or folders. 

It is also recommended that any other content needed for your compliance plan—such as logos and 
images—be kept in this folder, as well. 
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Generating customized Compliance Plan template with the 
CompliancePlan.xlsm tool 
The CompliancePlan_v####.xlsm tool is an Excel workbook that allows you to process your agency’s 
pavement and bridge asset management data to populate the generic compliance plan Word template, 
which you will personalize for your agency’s compliance plan. This tool runs calculations in the 
background so that the data you identify for use in the tool will be parsed into the appropriate formats for 
the compliance plan. 

NOTE: The worksheets in the ComplaincePlan_v####.xlsm workbook are protected to prevent 
inadvertent changes. Those protected worksheets require a password to unprotect the sheet. If you wish 
modify a protected worksheet, the password is “password”. 

 

Using the XLSM file for the first time and setting Trusted Location 
You will see a security warning when you open a macro-enabled Microsoft Office file for the first time. If 
this file is from a trusted source, select Enable Content (see figure below). 

 NOTE: You must enable macros for this workbook to function. 

 

 

You will also need to set the folder containing your bridge asset management plan tools as a trusted 
location. 

NOTE: This set of directions will work for setting trusted locations through either Microsoft Word or 
Excel. 
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1. Select File. 

 

 

 

2. Select Options. 

 

 The Word Options window will appear. 
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3. Select Trust Center in the Word Options menu. 

 

4. Select Trust Center Settings… 

 The Trust Center window will appear. 
 

5. Select Trusted Locations in the Trust Center window menu. 
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6. Select Add new location….  

 The Microsoft Office Trusted Locations window will appear. 

7. Select Browse. 

 

 

 

 The Browse window will appear. 

8. Browse to the folder you wish to set as a trusted location and select that folder in the main pane of 
the window; select OK.  

 

 The selected folder’s path should appear in the Microsoft Office Trusted Locations window. 

9. Select Subfolders of this location are also trusted; then, select OK. 



7 
 

 

10. In the Trust Center window, select OK.  

 Your selected folder has now been set as a trusted location. 
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Instructions Worksheet 

NOTE: When you open the CompliancePlan_v####.xlsm tool, you will be greeted with a welcome 
message in the Instructions worksheet. Please read the entire sheet before beginning. Then: 
 

1. Select Let’s Get Started (see figure below). 

 You will advance to the TOC worksheet (see figure below). Proceed to the TOC Worksheet 
section of this Instruction Guide. 
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TOC Worksheet 

NOTE: The TOC worksheet serves the location from which you can build your customized compliance 
plan template, and becomes available for viewing once finished with the Instructions worksheet (see 
figure below). 

 

1. Select Generate customized CP Word template on the TOC worksheet’s contents item Actions 
to Produce CP (see figure below). 

 

 The PLEASE NOTE: This process takes 3 to 5 minutes… dialogue box will display (see figure 
below).  

2. Select OK (see figure above).  
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Note: The process to generate the customized compliance plan Word template takes about three 
to five minutes. During this time, just allow Microsoft Office to run the generation process. You 
will see Microsoft Word automatically open and close; this is part of the process. User input is 
only necessary when the dialogue boxes display: 

 The You will need to locate your DataMacro_pavementAMP_v####.xlsm file… dialogue box will 
appear indicating that you will need to locate your pavement asset management plan 
DataMacro_pavementAMP_v2019.xlsm file (see figure below).  

3. Select OK (see figure above). 

 The Please choose your DataMacro_pavementAMP_v2019.xlsm file to open window will appear 
(see figure below). 
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4. Locate your completed DataMacro_pavementAMP_v####.xlsm file, and select Open (see figure 
above).  

 The You will need to locate your BridgeAMP-Data_v####.xlsm file… dialogue box will appear 
indicating that you will need to locate your pavement asset management plan 
BridgeAMP_v####.xlsm file (see figure below).  

5. Select OK (see figure above). 

 The Please choose your BridgeAMP-Data_v####.xlsm file to open window will appear (see 
figure below). 

6. Locate your completed BridgeAMP-Data_v####.xlsm file, and select Open (see figure above).  
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 Several workbooks will open.  

 A series of data comparison dialogue boxes—the CP vs. Pavement AMP… dialogue boxes and 
the Pavement AMP vs. Bridge AMP… dialogue boxes—will display (see figure below). 

7. Select Yes to retain the information from the blank complianceplan_blank.csv file for the CP vs. 
Pavement AMP… dialogue boxes or from your pavement asset management data for the 
Pavement AMP vs. Bridge AMP… dialogue boxes (see figure above). Repeat step 7 until no more 
data comparison dialogue boxes display. 

OR  

Select No to retain the information from your pavement asset management data for the CP vs. 
Pavement AMP… dialogue boxes or from your bridge asset management data for the Pavement 
AMP vs. Bridge AMP… dialogue boxes (see figure above). Repeat step 7 until no more data 
comparison dialogue boxes display. 

OR  

Select Cancel to exit the process. 
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 The Insert budget table now or later?... dialogue box will display (see figure below). 

8. Select Yes for now (see figure above). 

OR  

Select No for later (see figure above). Proceed to step 9 step result 2. 

 A Please choose your BridgeAMP-Budget_v####.xlsm file to open window will display (see 
figure below). 
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9. Locate your completed BridgeAMP-Budget_v####.xlsm file, and select Open (see figure above).  

 The cost projection/gap table will automatically be inserted into the compliance plan template. 

 The Identify forecasting method… dialogue box will display (see figure below). 
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10. Select Yes to identify forecasting method (see figure above). 

OR  

Select No to skip identifying forecasting method (see figure above). Proceed to step ## step 
result. 

 The Are you using NCPP or Roadsoft method of forecasting?... dialogue box will display (see 
figure below). 

11. Select Yes to customize your compliance plan template for the NCPP forecasting method (see 
figure above). 

OR  

Select No to customize your compliance plan template for the Roadsoft forecasting method (see 
figure above). 

OR  

Select Cancel to skip customizing your compliance plan template for the NCPP or Roadsoft 
forecasting method (see figure above). 
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 The Your customized Word template is ready to read and modify… dialogue box will display (see 
figure below). 

12. Select OK (see figure above). 

 The “CompliancePlan_v####.xlsm” tool will automatically close. Your customized compliance 
plan Word template will display in your compliance plan tools folder (see figure below). 
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Inserting content into the compliance plan Word template 

Inserting a logo 
There is one instance in the compliance plan where you will need to insert an image—the title page 
should incorporate your agency’s logo. A Picture placeholder indicates where the logo should be inserted.  

To insert a logo into the Picture placeholder: 

1. Select the Picture placeholder (shown below) where you plan to insert a logo (not a chart).  

2. Select the icon in the center of the placeholder. 

 The Insert Pictures dialogue box will open (shown below). 

3. Select Browse > in the From a file option row in the Insert Pictures dialogue box (see figure 
below).  
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 The Insert Picture window will open (see figure below). 

4. Navigate to your desired image using the Insert Picture window; select the image and then select 
Insert (see figure below). 

 The Picture placeholder will be replaced with the selected logo or graphic.  
 

 

Inserting charts 
You may also choose to add Excel charts or graphs to your compliance plan Word template (i.e., 
CompliancePlan_v2019.docm). To insert Microsoft Excel charts/graphs into the Word document: 

1. In the Excel workbook, select a chart/graph (see figure below).  

2. In the Excel workbook’s Home tab, select Copy from the Clipboard group to copy the 
chart/graph to the Windows clipboard. 

OR: Right-click on the chart/graph; select Copy from the dropdown menu. 

OR: Use the Ctrl + C keyboard shortcut. 
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3. In your compliance plan Word template (i.e., complianceplan_v2019.docm), place cursor at the 
position in the document where the chart or graph shoul be inserted. 

NOTE: If your compliance plan Word template was not open before you started this procedure, 
you may open it now. 

4. In Word’s Home tab, select Paste from the Clipboard group to paste the chart/graph that was 
copied to the Windows clipboard. 

OR: Right-click where your cursor is positioned, and select Paste from the dropdown menu. 

OR: Use the Ctrl+V keyboard shortcut. 

 

 

Inserting images 
Maps and other images will help communicate your inventory of assets and your asset management goals. 

NOTE: The procedure for creating maps in Roadsoft, exporting them as PDFs, and saving them as image 
files is detailed below. 

To insert an image into the Word template: 

1. Place cursor where you desire to insert an image. 

2. Select Pictures in the Insert ribbon Illustrations group.  

 The Insert Picture window will open (see figure below). 

3. Navigate to your desired image using the Insert Picture window; select the image and then select 
Insert (see figure below). 
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 The picture will insert into the Word template. 

4. Adjust by selecting the image and using Wrap Text option in the Picture Tools > Format ribbon 
(see figure below).  
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Creating map images from Roadsoft 
The compliance plan Word template has four map images: figure 1 – inventory of pavement assets, figure 
6 – pavement assets’ planned projects, figure 7 – inventory of bridge assets, and figure 9 – critical links in 
the road and bridge network. The following procedures detail the creation of each of these maps in 
Roadsoft and exporting them PDF files; an additional procedure explains the process of saving a PDF file 
as an image. The preceding section (above)—Inserting content into the compliance plan Word 
Template—details the procedure for inserting images into a Word document. 

 

Creating image for 1. Pavement Assets > Inventory of Assets (Figure 1) 

1. Display roads according to rating. 

a. Select Show Legend Window ( ) in the Map tool options bar. 

 The Road Legend window will open (see figure below). 

b. Select Open Legend Builder ( ) in the Road Legend window (see figure below).  

 The Legend Builder window will open (see figure below).  
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c. Choose the Good/Fair/Poor field from the Legend Field dropdown list (see figure 
above). 

d. Move the good, fair, and poor rated road values down to the Query box of the Legend 
Builder window.  

i. Highlight good, fair and poor unique values by selecting the first value (e.g., 
Good), holding down the Alt key on your keyboard, and selecting the subsequent 
unique values (e.g., Fair and Poor).  

ii. Select Add Selected Unique Value(s) ( ).  

e. Select one condition Query value in the Items list. 

f. Adjust color and font size of the selected value using Feature and Outline in the Item 
Properties box (see figure below).  

g. Select Apply Property to All Items to apply adjusted color and font size to all Query 
items (see figure below). 

 The Apply Selected Property dialogue box will open (see figure below).  

h. Select Yes in the Apply Selected Property dialogue box (see figure above). 

i. Select Apply ( ) in the bottom right of the Legend Builder window once the legend 
settings are correct. 
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 The Road Legend window will display the applied legends (see figure below). 

2. Add an unpaved road filter. 

a. Select Filter ( ) in the Map tool options bar. 

b. Select Apply Saved Filter as Selection… from the Filter dropdown list. 

 The Load Saved Filter window will open (see figure below). 

c. From the list of filters, apply both the city and county unpaved roads filters (see figure 
below). 

d. Select OK. 
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 The filters will be applied. 

e. Select File from the main menu, and select Export/Upload >. 

f. Select Export Layer to File from the Export/Upload > flyout menu (see figure below). 

 The Export Road to Shapefile window will open (see figure below). 

g. Select an Export Path (e.g., folder where you are storing your materials for your 
compliance plan) and enter a File Name (e.g. unpavedroadlayer) (see figure above). 

h. Import the shape file as a layer. 
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i. Right-click on Road from the Map Layers window (see figure below). 

ii. Select Add Layer from the flyout menu (see figure above). 

 The Add Map Layer window will open (see figure below). 

iii. Select the External Layer tab in the Add Map Layer window (see figure above). 

iv. Browse for the exported shape file using the Path browse button (see figure 
above). 

 The Select external file to add to the map window will open (see figure below). 

v. Navigate in the Select external file to add to the map window to the shape file 
exported in step 1, select the shape file, and select Open. (see figure below). 
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vi. Select OK in the Add Map Layer window. 

 The shape file will be added as a Line Layer in the Map Layers window (see 
figure below). 

i. Right-click on the Road category once again (see figure above). 

j. Select Layer Properties ( ).  

 The Road Layer Properties window will open (see figure below). 

k. Select the Legend tab of the Road Layer Properties window (see figure below). 

l. Adjust color and font size of the roads in the unpaved road layer (see figure below). 

m. Select Apply (see figure below). 

n. Ensure that both the shape layer (e.g., unpavedroadlayer) and the Road layer are 
selected in the Line Layers group of the Map Layers window; de-select the Bridge and 
Intersection layers of the Point Layers group. 
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3. Print the map as a PDF. 

a. When the map is ready, select File from the main menu (see figure below). 

b. Select Print Current Map View from the File menu (see figure below). 

 The Map Print Setup window will open (see figure below). 
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c. Enter desired label information into the Title and Subtitle input boxes, and adjust the 
Scalebar Units and legend as desired (see figure above). 

d. Select Print Map (see figure above). 

 The Windows Print window will open (see figure below). 

e. Select Microsoft Print to PDF from the Print window (see figure above). 

f. Select Print (see figure above). 

 The Save Print Output As window will open. 

g. Navigate in the Save Print Output As window to the desired folder containing compliance 
plan materials, enter a descriptive file name in the File name input box (e.g., 
complianceplan_figure1), and select Save. 
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Creating image for 1. Pavement Assets > Planned Projects (Figure 6) 

1. View projects. 

a. Select Show Legend Window ( ) in the Map tool options bar. 

 The Road Legend window will open (see figure below). 

b. Select Open Legend Builder ( ) in the Road Legend window (see figure above).  

 The Legend Builder window will open (see figure above).  

c. Select Scheduled Maintenance Year from the Legend Field dropdown box in the 
Legend Builder window (see figure above). 
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 Relevant unique values will populate the Unique Values box (see figure below). 

d. Select a span of years in the Unique Values box by clicking the first year, holding down 
the Shift key, and then clicking the last year in the range (see figure below).  

NOTE: Since the compliance plan is looking forward at the project you plan to do on your 
network, the selected span of years should begin during or after the publication year of 
your compliance plan and include the subsequent years corresponding to the subsequent 
years covered in your compliance plan. 

 All the selected years should be highlighted in blue. 

e. Select Add Selected Unique Value(s) ( ) in the Unique 
Values box of the Legend Builder window (see figure above). 

NOTE: The years should appear in the Items box (lower left). 

NOTE: If any other values are listed in the Items box, these values should be deleted so 
that only the desired project years are listed (see figure below).  

f. Select one year Query item in the Items list. 
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g. Adjust color and font size of the selected item using Feature and Outline in the Item 
Properties box (see figure below).  

h. Select Apply Property to All Items to apply adjusted color and font size to all Query 
items (see figure below). 

i. The Apply Selected Property dialogue box will open (see figure below).  

j. Select Yes in the Apply Selected Property dialogue box (see figure above). 

k. Select Apply ( ) in the bottom right of the Legend Builder window once the legend 
settings are correct.  

 The Road Legend window will display the applied legends (see figure below).  
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l. Ensure that the Road layer is selected in the Line Layers group of the Map Layers 
window; de-select the Bridge and Intersection layers of the Point Layers group (see 
figure above).  

2. Create a new project. 

a. In the Map window, select Road Segment in the Map tool options bar (see figure below). 

b. Select the segment(s) of road on the map where the project will take place (see figure 
above).  

 Selected segment(s) will be highlighted. 

c. Select the Projects in the Map tool options bar (see figure above). 

d. Select Add Project Using Selection… in the Projects dropdown menu. 

 The Add Project window will open (see figure below). 
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e. Fill out Project Information fields (i.e., Location, Project Number/OD. Surface Subtype, 
Life Expectancy, Estimated Costs, Total Costs, Start Date, status, Completion/Open To 
Traffic Date, Reactionary Project, Warranty Project, Description, Source of Funds, 
Memo). 

NOTE: As long as the Start Date field data falls within the selected span of years (see 
step 1.c), the road segments will be displayed with the same color as the other road 
projects within the same span of years. 

f. Select Save. 

3. Print the map as a PDF. 

a. When the map is ready, select File from the main menu (see figure below). 
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b. Select Print Current Map View from the File menu (see figure below). 

 The Map Print Setup window will open (see figure below). 

c. Enter desired label information into the Title and Subtitle input boxes, and adjust the 
Scalebar Units and legend as desired (see figure above). 

d. Select Print Map (see figure above). 

 The Windows Print window will open (see figure below). 
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e. Select Microsoft Print to PDF from the Print window (see figure above). 

f. Select Print (see figure above). 

 The Save Print Output As window will open. 

g. Navigate in the Save Print Output As window to the desired folder containing compliance 
plan materials, enter a descriptive file name in the File name input box (e.g., 
complianceplan_figure6), and select Save. 

 

 

Creating image for 2. Bridge Assets > Inventory of Assets (Figure 7) 

1. Display bridges according to rating. 

a. Ensure Road is selected in the Line Layers group of the Map Layers window but has no 
legends associated with it. 

NOTE: To view legends associated with the Road layer: 

i. Select Road in the Map Layers window. 

ii. Select Show Legend Window ( ) in the Map tool options bar. 

iii. Select any legends listed, and select Delete a saved legend ( ). 

b. Select Bridge in the Map Layers window.  

 A prompt will appear if bridge data needs to be imported.  
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NOTE: To re-import bridge data, right-click on the Bridge and select Re-Import Bridge 
Data from the dropdown menu (see figure below). 

c. Right-click on Bridge in the Map Layers window. 

d. Select Legend Builder… ( ) from the dropdown menu.  

 The Legend Builder window will open (see figure below). 

e. Select Good/Fair/Poor Rating from the Legend Field dropdown list.  

 Relevant unique values will populate the Unique Values box.  

f. Select the Good, Fair, and Poor values by clicking the value (e.g., Good), holding down 
the Ctrl key, and then clicking all subsequent desired values (e.g., Fair and Poor).  
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 All the selected unique values should be highlighted in blue.  

g. Add Selected Unique Value(s) ( ) in the Unique Values box 
of the Legend Builder window. 

NOTE: The good, fair, and poor values should appear in the Items box (lower left). 

NOTE: If any other values are listed in the Items box, these values should be deleted so 
that only the desired project years are listed (see figure below).  

h. Select the first Query item in the Items list, i.e., Good/Fair/Poor Rating = Good. 

i. Adjust color to green and font size of the selected item using Feature and Outline in the 
Item Properties box.  

j. Repeat steps 1h and 1i for Good/Fair/Poor Rating = Fair adjusting color to yellow and 
Good/Fair/Poor Rating = Poor adjusting color to red.  

k. Select Apply ( ). 

 The map will display all bridges in the county with the rating-specific legend applied (see 
figure below). 

2. Add a filter to display bridges based on ownership. 

a. Select Filter ( ) in the Map tool options bar. 

b. Select Filter Builder… from the Filter dropdown menu. 
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 The Bridge Filter Builder window will open (see figure below). 

c. Search for “owner” in the search bar of the Bridge Filter Builder window (see figure 
above).  

d. Select Owner in the Field list (see figure above). 

 The available operator(s) and value(s) will display. 

e. Select the desired operator in the Operator box and the desired value(s) associated with 
the selected operator in the Value box (see figure above) 

f. Select Add (to the right of the Value box) (see figure above). 

g. Select Apply as Filter in the Bridge Filter Builder window. 

NOTE: You may be prompted to save this filter in order to apply it. In this case, the Save 
Filter window will open; enter a unique name in the Name input box, (optional) associate 
the filter with a group using the Group dropdown list, (optional) share/create a private the 
filter by selecting/de-selecting Shared Filter check box, and then select Save As. 
Alternatively, if you are updating an already-saved filter, you may have to re-save the 
filter; select Save in the window prompting you to update the saved filter. 

h. Exit the Bridge Filter Builder window using the x in the top right corner. 

i. Check to make sure only the bridges owned by the value(s) chosen are displayed on the 
map. 

3. Print the map as a PDF. 

a. When the map is ready, select File from the main menu (see figure below). 
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b. Select Print Current Map View from the File menu (see figure below). 

 The Map Print Setup window will open (see figure below). 

c. Enter desired label information into the Title and Subtitle input boxes, and adjust the 
Scalebar Units and legend as desired (see figure above). 

d. Select Print Map (see figure above). 

 The Windows Print window will open (see figure below). 
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e. Select Microsoft Print to PDF from the Print window (see figure above). 

f. Select Print (see figure above). 

 The Save Print Output As window will open. 

g. Navigate in the Save Print Output As window to the desired folder containing compliance 
plan materials, enter a descriptive file name in the File name input box (e.g., 
complianceplan_figure7), and select Save. 

 

 

Creating image for 6. Risk of Failure Analysis (Figure 9) 

1. Select Road in the Map Layers window. 

2. Select Road Segment in the Map tool options bar (see figure below). 

3. In the Map window, select a segment or multiple segments of road (see figure below).  

NOTE: Hold down the Ctrl on your keyboard when selecting with the mouse in order to make 
multiple selections, or hold down the Alt key on your keyboard when selecting with the mouse in 
order to de-select a segment. 

4. Right-click on any of the selected segments (see figure above).  
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5. Select Save Selection as Filter… from the dropdown list (see figure below). 

 The Save Selection as Filter window will open (see figure below). 

6. Enter a name in the Name input box for filter. 

7. If a risk group already exists, select risk group from the Group dropdown list. 

OR: If a risk group does not exist, type in the name of a new risk group in the Group field. 

8. Right-click on a selected high-risk segment in the Map window.  

9. Select View Module… from the dropdown list. 
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 The Road Module tab will open (see figure below).  

10. Select the User-Defined tab located on the left side of the Road Module tab (see figure above). 

 The User-Defined window will display (see figure below).  

11. Select the plus sign to the left of the first user-defined field, “User Def 4” (see figure above).  

 This will expand the field options for that user defined field.  

12. Select the Change Label… option associated with the User Def 4 field options (see figure 
above). 
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 The Specify Label window will open (see figure below). 

13. Enter a name for the user-defined field in the input box: “Risk” (see figure above).  

14. Select OK. 

15. Select the Add/Edit Risk… option associated with the Risk field options 

 The View/Edit Lookup/Defaults window will open (see figure below). 

16. Select Add (see figure above). 

 The Edit Lookup window will open (see figure above). 

17. Enter a new name in the Description input field and an abbreviation in the Abbreviation input 
field for the new high-risk section.  

18. Select Save. 

NOTE: Save these options for the “Risk” user-defined field before creating values for every other 
high-risk section.  
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19. Select the X in the top right corner of the View/Edit Lookup/Defaults window to close the window 
and return to the map when finished. 

 User-defined values will now be added to the Road Module. 

NOTE: These newly-added user-defined values still need to be applied to the appropriate 
segments. The Multi-edit tool is used to accomplish this. 

20. Select the Map tab. 

21. Right-click on the map. 

22. Select Apply Saved Filter as Selection… from the dropdown menu. 

23. Use the Group dropdown to locate the Risk group.  

24. Select OK. 

25. Select View Module ( ) in the Map tool options bar.  

26. Select Multi-edit ( ) in the Road Module tab (see figure below). 

27. Select All Segments from the dropdown menu. 
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 The Road Multi-edit window will open (see figure below). 

28. Select ALL Selected Segments from the PR dropdown list. 

29. Select User-Defined from the Inventory section of the window (see figure below).  
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30. Select Risk in the User Defined Fields box, and use the dropdown list at the right side of the field 
to select the first segment.  

31. Repeat this steps 29 and 30 for each of the segments. 

32. Apply legends to high-risk segments. 

c. Select Show Legend Window ( ) in the Map tool options bar. 

 The Road Legend window will open (see figure below). 

d. Select Open Legend Builder ( ) in the Road Legend window (see figure above).  

 The Legend Builder window will open (see figure above).  

e. Select Risk from the Legend Field dropdown box in the Legend Builder window (see 
figure above). 

 Relevant unique values will populate the Unique Values box.  

f. Select the desired segments.  

 All the selected segments should be highlighted in blue.  

g. Select Add Selected Unique Value(s) ( ) in the Unique 
Values box of the Legend Builder window. 

h. Values will be added to the Query in the Items box. 

i. Select the first Query item in the Items list. 

j. Adjust the color and font size using Feature and Outline in the Item Properties box.  

k. Select Apply Property to All Items to apply adjusted color and font size to all Query 
items. 

OR: Repeat steps 32g and 32h for each Query item to create a unique legend for each 
item. 

l. Select Apply ( ). 
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33. Print the map as a PDF. 

c. When the map is ready, select File from the main menu (see figure below). 

d. Select Print Current Map View from the File menu (see figure below). 

 The Map Print Setup window will open (see figure below). 

e. Enter desired label information into the Title and Subtitle input boxes, and adjust the 
Scalebar Units and legend as desired (see figure above). 

f. Select Print Map (see figure above). 
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 The Windows Print window will open (see figure below). 

g. Select Microsoft Print to PDF from the Print window (see figure above). 

h. Select Print (see figure above). 

 The Save Print Output As window will open. 

i. Navigate in the Save Print Output As window to the desired folder containing compliance 
plan materials, enter a descriptive file name in the File name input box (e.g., 
complianceplan_figure9), and select Save. 

 

 

Creating images from PDF files 
To create images from the four PDF Roadsoft map files, you will need a PDF reader/writer software 
program that allows you to save the PDF as an image. An example of this software is Adobe Acrobat.  

1. Open each PDF map in the PDF software program. 

2. Select File from the main menu. 

3. Select Save As from the File menu. 

4. Change Save as type to an image format (e.g., JPG, PNG, GIF, TIF). 

Note: It is important to ensure that the save location for the file is the same folder where you are 
saving all of your compliance plan materials. 
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Note: The file name should remain the same as the PDF file name, but the extension will change 
from “.pdf” to the file extension corresponding with your selected image format. 

5. Select Save. 

6. Follow the procedures (detailed above) for inserting images into your compliance plan Word 
template. 
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Completing the Word template 

The compliance plan Word template is automatically linked to your newly-generated complianceplan.csv 
file, which will populate the template with content based on your agency’s specified circumstances. 
However, several places in the Word template still require your input and editing. 

1. Address all orange-text field prompts or comments/“Your Content Here” prompts (see figure 
below). 

NOTE: <#Orange text fields> are placeholders for user-entered data. Each of these placeholders 
can be identified by its field formatting, its orange color, and its unique tagging “<#”. Each of 
these placeholders has a different prompt depending on the type of information to be inputted. An 
example of an orange text field is: 

 

<# YOUR CONTENT HERE: Insert percent in ## format> 

 To address these prompts: 

a. Navigate to the orange-text field prompts or comments/“Your Content Here” prompts. 

i. Place cursor on the cover page, then toggle to each prompt using the F11 key on 
your keyboard. 

OR: Visually search the document for orange-text fields and/or “Your Content 
Here” prompts. 
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OR: Select Find from the Home ribbon Editing group, and enter “<#” in the 
Search document input box. (Note: This will also find the missed auto-fills; see 
step 4, below). 

b. Fill in content/responses manually. 
 

NOTE: Some orange text field prompts are associated with dropdown selections for 
content/responses. The chosen dropdown selection or the manually-entered content/response 
should flow with the context of the paragraph or section. 

 

2. Address all teal-commented optional sections (see figure below). 

NOTE: Teal-commented optional sections signal entire sections that are optional and can be 
deleted based on hour agency’s circumstances. These sections are placed in content controls. In 
many cases, you will have a choice between alternate teal-commented sections for the same entire 
section; you may delete one or all options for the entire section if it does not apply to your 
agency’s circumstances. Optional sections are accompanied by instructions in the teal-highlighted 
comment. An example of an optional section’s instructional comment is: 

Use and/or modify the following section by right-clicking the content control and then “Remove 
Control” to retain text.  
To delete, select the control handle (entire content control area will highlight) and use your Delete 
key to delete content.  



52 
 

 

Scrolling over an optional section will show its content control and will shade the content control 
in grey (see figure above). At this point, you may address the teal-commented optional section in 
one of three ways: 

a. OPTION 1: Use and/or modify optional sections content: 

i. Right-click anywhere inside the content control. 

 A drop-down menu will appear. 

ii. Select Remove Content Control (see figure below). 

 

 The content control is now removed and the text has merged with the body of the 
document. You may now edit this section as part of the body itself. 

b. OPTION 2: Create new sub-sections: 

i. Place cursor in optional section content control. 
 

 The content control frame and handle (upper left corner) will open. 

ii. Select the content control handle (see figure below). 

iii. Copy the content control: 
In the Home ribbon, select Copy  from the Clipboard group.  
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OR: Use the Ctrl+ C keyboard shortcut. 

iv. Place cursor at the end and outside the content-controlled area. 

v. Paste the copied content control: 
In the Home ribbon, select Paste from the Clipboard group.  

OR: Use the Ctrl+ V keyboard shortcut. 

c. OPTION 3: Delete optional sections entirely. 

i. Place cursor in optional section content control. 

 The content control frame and handle (upper left corner) will open. 

ii. Select the content control handle (see figure above). 

iii. Press the Delete key on your keyboard. 

 This removes the entire optional section. 
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3. Address comments. 

NOTE: Comments appear along the right side of the Word document. If you do not see 
comments, ensure that the markup dropdown menu in the Review ribbon Tracking group says 
“All Markup” or “Simple Markup”. If you select “Simple Markup”, you will need to select Show 
Comments in the Comments group (see figure below). 
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Generating cost projection/gap analysis table for bridge 
assets from budget template 
The BridgeAM-Budget_v####.xlsm Excel workbook is a comprehensive budgeting tool that allows you 
to plan your bridge maintenance budget allocations by organizing various types of bridge maintenance 
projects and their associated costs. It also helps to identify gaps in funding. The cost projection/gap 
analysis table will present your data in a format that can be more easily transferred into your customized 
compliance plan Word template’s section 2. Bridge Assets subsection Programmed/Funded Project, Gap 
Analysis, and Planned Projects. 

To create a cost projection/gap analysis table for you compliance plan: 

1. Open the BridgeAM-Budget_v####.xlsm tool, and ensure that the Summary worksheet is the active 
worksheet. 
 

2. Select the Create Project Cost Projection/Gap Table button (see figure below). 

 

NOTE: If a cost projection table has already been created, the You already have a CP table… 
dialogue box will display. Select Yes to delete the current cost projection table and continue with 
creating a new one, OR select No to exit the process (see figure below). 
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 The CPTable worksheet will automatically generate, and cells A1 through the last column and last 
row will automatically be selected and copied to the Windows clipboard; the You can copy this table 
into either… message box will display with directions for the next step (see figure below).  

NOTE: The CPTable worksheet orders all projects, first, by project type (in this order: 
Reconstruction, Replacement, Rehabilitation, Capital Preventive Maintenance, Scheduled 
Maintenance, and Other) and, then, by date/gap. 
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3. Select Yes to insert the cost-projection/gap table into your compliance plan Word template (or your 

bridge asset management plan Word template). Proceed to the step 3 step result. 

OR 

Select No to skip inserting the cost-projection/gap table into your bridge asset management plan 
template (or your compliance plan template). Proceed to Updating the Table of Contents section of 
this instruction guide. 

 The Please use the file dialogue window… message box will display. 
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4. Select OK. 
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 The Please select your Word template file file explorer dialogue box will display (see figure below). 

 

5. In the file explorer dialogue box, select the CompliancePlan_v####_customizedtemplate.docx (or 
bridge asset management plan template) file found in the tools parent folder, and select Open (see 
figure above). 
 
NOTE: If the table has been placed in the Word template previously, you will need to delete the table 
and replace the table with the following text: PasteCPTable. This text should be formatted with 
Body style in the Styles group (see figure below). To delete table, select the table and right-click on 
the box with the four-directional arrow that displays at the top left corner of the selected table; then, 
select Delete Table from the dropdown menu (see figures below). 
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  The cost projection/gap table will be placed in the selected Word template. The You can copy this 
table to another Word template… message box will display (see figure below). 

 

6. Select Yes to insert the cost-projection/gap table into your bridge asset management plan Word 
template (or compliance plan Word template). Repeat steps 3, 4, and 5; and proceed to step 7. 

OR 

Select No to skip inserting the cost-projection/gap table into your compliance plan template (or 
bridge asset management plan template). Proceed to Updating the Table of Contents section of this 
instruction guide. 

7. Save and close the BridgeAM-Budget_v####.xlsm tool. 

8. Open the Word template and format table as desired (see figure below). 
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Updating the Table of Contents 
Finally, make sure to update the Contents field to match the completed document. 

1. Go to the Contents section on the second page of the document. 

2. Select the Contents field.  

 The Contents listing will appear boxed with buttons located in the upper left corner of the field.  

3. Select the Update Table button. 

4. Select Update page numbers only from the Update Table of Contents dialog box that opens. 

 
 

NOTE: These procedures for the MS Word template file will generate one Word document. An export-to-
PDF process similar to the Excel export detailed in the Entering data into the Excel template: Appendix 
section can be used to save the Word file as a PDF. This PDF can be merged with the three PDF appendix 
files using the full version of Adobe Acrobat or a free, open-source app that has a PDF-merge capability. 
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Inserting Appendixes 
To create a single compliance plan document, save the compliance plan Word template, the pavement 
asset management plan Word document, the bridge asset management plan Word document, and any 
other associated files as PDFs. Then, using a PDF editing software program, merge the PDFs into a single 
PDF. 

To save a Word document as a PDF: 

1. Select File in the ribbon menu.  

2. Select Save as Adobe PDF in the File sidebar menu (see figure below). 

OR: Select Print in the File sidebar menu (see figure above). 

 The Windows Print window will open (see figure below).  
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a. Select Microsoft Print to PDF from the Print window (see figure above). 

b. Select Print (see figure above). 

 The Save Print Output As window will open. 

c. Navigate in the Save Print Output As window to the desired folder containing 
compliance plan materials, enter a descriptive file name in the File name input box 
(e.g., complianceplan_2019 or complianceplan-appendix1_2019), and select 
Save. 

OR: In the Home ribbon, select Create and Share Adobe PDF in the Adobe Acrobat group 
(see figure below). 

3. Once all necessary files have been saved as a PDF, proceed with using a PDF editor to 
compile all necessary PDFs into a single PDF. 
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